Train the Trainer Toolkit

Resources for developing trainings in Basic and Business Digital Literacy

PART IV. THE TRAININGS
DIGITAL LITERACY SUMMARY
BASIC COMPUTER SKILLS, MODULES 1-4

June 2012

These materials were created collaboratively by the New Mexico Department of Information Technology, Fast Forward New Mexico, and the New Mexico State Library, under grants provided by the National Telecommunications and Information Administration. These materials are not to be used for profit.
# Table of Contents

**PART IV. THE CLASSES** .......................................................................................................................... 2

**DIGITAL LITERACY SERIES** .................................................................................................................... 2

- **Overview and goals** .............................................................................................................................. 2
- **Series synopsis** ...................................................................................................................................... 2

**BASIC COMPUTER SKILLS – MODULE 1** ............................................................................................... 4

- **Summary, challenges, and instructional strategies** ............................................................................... 4
- **Presentation and text** ............................................................................................................................ 5
- **Video model for trainers** ...................................................................................................................... 23
- **Handout** .............................................................................................................................................. 24
- **Assessment** .......................................................................................................................................... 26

**BASIC COMPUTER SKILLS – MODULE 2** ............................................................................................ 27

- **Summary, challenges, and instructional strategies** ............................................................................... 27
- **Presentation and Text** ............................................................................................................................ 28
- **Demonstration training video** .............................................................................................................. 52
- **Handouts** ............................................................................................................................................ 53
- **Assessment** .......................................................................................................................................... 54

**BASIC COMPUTER SKILLS – MODULE 3** ............................................................................................ 55

- **Summary, challenges, and instructional strategies** ............................................................................... 55
- **Presentation and Text** ............................................................................................................................ 56
- **Demonstration training video** .............................................................................................................. 70
- **Handout** .............................................................................................................................................. 71
- **Assessment** .......................................................................................................................................... 72

**BASIC COMPUTER SKILLS – MODULE 4** ............................................................................................ 73

- **Summary, challenges and instructional strategies** ............................................................................... 73
- **Presentation and Text** ............................................................................................................................ 74
- **Demonstration training video** .............................................................................................................. 104
- **Handout** .............................................................................................................................................. 105
- **Assessment** .......................................................................................................................................... 107

**RESOURCES FOR BASIC COMPUTER SKILLS CLASSES** ................................................................. 108

- **Websites and online training** ............................................................................................................... 108
- **Instructional Strategies for Basic Computer Skills** ............................................................................. 110
- **Instructional strategies for Basic Computer Skills - training video** .................................................. 117
PART IV. THE CLASSES

DIGITAL LITERACY SERIES

Overview and goals

The digital literacy series offers trainings suitable for novices, beginners, users with limited or narrow skill sets, and users who are self-taught and seek a better sense of cohesion and integration of the skills and comprehension they have achieved. The goals of the trainings are to several:

To establish an understanding of computer and Internet terminology, concepts, and skills
To build developing skills in computer and Internet use
To provide hands-on activities and practices in these basic computer and Internet tasks
To provide a supportive, scaffolded learning environment for these developing skills
To engage students in the learning process, in order to promote independent learning
To inculcate in the learner a sense of self-efficacy that promotes sustainable learning

Series synopsis

The series offers instruction in the most basic skills and information, including enough information and practice to move the student from incapacity to capacity while still meeting students at their level, even if it is the level of novice. The topics covered include:

Basic Computer Skills
Module 1
- Understanding basic computer terminology, functions, styles, and parts

Module 2
- Turning a computer on and off
- Using a keyboard and mouse

Module 3
- Operating system elements (desktop, icons, start menu)
- Working with windows (key functions)

Module 4
- Introductory word processing skills (understanding the ribbon and tabs, creating, editing, saving files

Introduction to the Internet
Module 1
- Understanding the Internet
- Websites, browsers, web addresses, navigation
Module 2
- Using search engines
- Focusing searches and evaluating websites

Module 3
- Using email to communicate
- Setting up and using Gmail
- Attachments and netiquette

Module 4
- Online resources for health, education, and employment

Selecting and Maintaining a Computer
Module 1
- Matching computer styles and user needs
- Key component and standard requirements

Module 2
- Setting up and connecting to the Internet
- ISPs and broadband options

Module 3
- Security software
- Updating security and operating systems
- Cleaning and backing up files

Security and Safety in the Digital Age
Module 1
- General guidelines
- Expectations and behaviors
- Dealing with email, texting, & social media

Module 2
- Protecting personal and financial security online

Module 3
- Monitoring and controlling Internet content
BASIC COMPUTER SKILLS – MODULE 1

Computer types, hardware, and software

Summary, challenges, and instructional strategies

This module begins with the most basic introduction to computer styles, parts, and their functions. Because many in this class may be beginners, it is important to keep the larger, organizational structure clear at all times and refer back to it frequently, so it is easier for the audience to track where in the class they are at every moment.

There is a good bit of terminology in the module, and if this material is completely new to people, the terms may seem overwhelming. This can be countered by reviewing previous terms frequently as you move forward, and by writing key terms on a separate whiteboard or blackboard. A group review exercise, in which all the parts and their functions are reviewed, is another helpful tool for aiding memory. The number of new terms also lends itself well to reinforcement with an assessment that requires discrimination between the different parts and their functions.

Different levels of students in this class can be a challenge, as some may know much or most of the content and others be novices. Address this potential for imbalance from the start of class by asking about everyone’s background and using the more advanced students to aid in scaffolding learning for less experienced. State this as an intentional tool in your classroom, and encourage this peer training. It will help you build community in the class room as students will begin by engaging in more interactions than in a traditional classroom. This will also help minimize the separation between instructor and students, creating a more open and egalitarian atmosphere in the room which will put people at ease and make it easier for them to learn.
In this module, you can expect to learn the following skills and tasks:  First, you will develop a familiarity with basic computer terminology. This is important, since beginning skills require that you be able to understand and use the vocabulary associated with computers. Second, you will learn about the basic parts of computers and their functions. This will help you understand how the computer works and will help you understand future discussions about computer parts. Third, you will begin to acquire mousing and keyboarding skills. Using a mouse and a keyboard are important techniques for computer use – sort of like learning to use a hammer and saw if you want to become a carpenter. You will practice these skills and be provided with resources that allow you to continue that practice on your own.
Let’s get started. We’ll begin by talking about the different kinds of home computers that are most common. This will help us get familiar with some key terminology, and will provide a solid context, or background, for some ideas that will be developed later.

We will consider briefly four types of computers most common today. These are the desktop computer, the laptop computer, and what we once called personal digital assistants and are now generally referred to as smartphones, and the tablet computer, such as the iPad.

Here you see the relative size of each of these computers. Because of their size, each of these computer styles is a better suited for different circumstances. Not only are smaller size machines lighter and more portable, but smaller size equipment also has smaller components and thus more limited capacity. In institutions such as offices, schools and libraries, where portability is not required, desktop models are most common. They also have the best capacities (we’ll discuss this more later). For individuals, especially those requiring or preferring some mobility of their
machine, laptops are becoming increasingly popular. And for busy professionals who need to have their email, calendars, and files available for access while they are on the go, tablet computers and smartphones are almost a necessity.

Let’s take a moment to look at each of these four styles of computer a bit more closely and understand their capacities and limits.

Desktops are generally the most luxurious of the personal computer. They tend to have larger screens (you can purchase ones that are substantially larger) and a larger storage capacity than other models. The case of the computer, that houses the processing unit, is called a tower if it is upright or the system unit.

The screen is referred to as a monitor. It is separate from the system unit.

The Keyboard is like a typewriter keyboard and is used to type commands and create documents. The mouse is an external device used, together with the keyboard, to navigate the screen, select information, and initiate actions and commands.
The laptop is like a smaller, self-contained version of a desktop. All the features that we saw on the desktop — monitor, keyboard, mouse, system unit — are built into a single unit in a laptop. The screen and keyboard are often a bit smaller than those of a desktop and the mouse is a “touchpad” with two clicker keys.

There are smaller versions of this kind of computer called netbooks. Netbooks have limited storage and internet capacity, but are good for taking notes in class and checking email.

There are also newer versions of laptops called tablet style computers that have a keyboard built in as part of the screen, and are thus in the shape of a single tablet rather than that of a laptop in which keyboard and screen are hinged together. This type of screen, that contains a keyboard and other command keys, is called a touchscreen.

The newest style of computer is the tablet style computer. These have a keyboard built in as part of the screen, and are thus in the shape of a single tablet rather than that of a laptop in which keyboard and screen are hinged together. You use the keyboard by touching the screen, hence the term “touchscreen”. Instead of a touchpad or mouse, you navigate the screen by using your hands on the screen to touch buttons and links, turn pages, and scroll down and across pages. A tablet can be used as computer, book reader, gaming device, and music and video player. The increasing
development of these machines and ever shrinking size of components has allowed tablet capacity to grow while still maintaining an elegant and sleek profile.

Smartphone, such as the Blackberry, Droid, and iPhone, have increasing capacities as much more than phones, especially the “second generation” devices. These telephones that provide additional features such as calendars, music access, a variety of application tools called apps, and allow you Internet connectivity that enables you to receive email or search the web. In some cases, smartphones can be used as the key receiver for Internet signal and allow you to hook up a monitor and keyboard for increased functionality.

Now that we’ve looked a bit at the most common types of personal computers, let’s consider the key components of the computer.
We are going to begin with what is referred to as computer hardware. Hardware simply refers to the parts that are actual physical parts. They could be large parts that we can see easily, such as the monitor or keyboard, or they could be smaller, internal parts, such as memory cards, the fan, or the processing chip. All of these are consider to be computer hardware.

Computer hardware generally consists of mostly metal parts with electronic circuitry and wiring.

The key elements of the Hardware are:

- Central Processing Unit (CPU)
- Hard drive
- Random Access Memory (RAM)
- Ports and Peripherals

Let’s look at each of these a bit more closely.

The first piece of computer hardware that we are going to consider is the central processing unit, or CPU.

The central processing unit (CPU) is the “brains” of a computer. It is often called a microprocessor or microprocessing chip.

We can think of the CPU as a computation engine. That is, it is the part of the computer that makes all the calculations that allow it to perform operations. It also allows the computer to run software applications. It is the
primary factor in determining how fast the computer can process information and how rapidly it runs. When we talk about computer speed, we are generally referring to the speed of the microprocessor.

Despite this ability, the CPU is a very small.

You can see here that this CPU is much smaller than a penny.

CPUs are made of thin silicon layers with electronic circuitry on and between layers. All the programming needed to process information and make calculations is contained in that miniscule area of circuitry. New models of chips are multi-core and contain one or more processing chips within another, creating dual and quadruple core processors that can run even faster.
The next key piece of computer hardware that we want to consider is the hard drive.

The *Hard drive* is the physical location on which your computer’s information and data are stored. The hard drive looks like an aluminum box with circuits on the outside. Inside, it contains electronic disks on which information is stored in electronic form. This information can be read from and written to with electronic arms that function like a very precise record player arms.

Here you can see the inside of the hard drive with the electronic circuitry on one side of the box.
On the other side are the disks onto which information is stored and from which it is retrieved. The read-write arm in the image on the right shows the mechanism by which information is transferred on and off the discs. What this means is that each time to save information to your drive, directions are sent electronically to this arm that tell it to transfer that information onto one of the discs. That is, the arm “writes” the information onto the discs. Similarly, when you retrieve information from your hard drive (such as a memo you wrote or a photo you took), directions are sent electronically to this arm that tell it precisely where to go in order to access that exact file. Like a an old-style record player that played music from vinyl records, the computer “reads” the information from the disc on the hard drive. Most often, we do not hear the information (unless we are listening to some music we saved), but instead we see it on our screen.

So far, we’ve mentioned both the CPU, or processor, and the hard drive, as key elements of hardware on the computer. The third item we are going to consider is what is referred to as the memory of the computer. Actually, there are several different kinds of so-called memory in a computer, but the most commonly mentioned one is known as RAM – random access memory – and that is the type of memory we want to discuss now.
RAM refers to what we call the computer’s “temporary” memory.

Unlike human memory, which we associate with the brain, RAM memory is similar to work area, rather like a desktop.

It affects how much information can be worked with at a given time. You can think of the measurement of RAM as a measurement of how much space you have on your desktop and how much you can bring out to work on at one time.

RAM also affects how quickly a computer will start up and how fast it will let you work, since the more programs you can open simultaneously, the more quickly your computer can execute tasks.

The amount of RAM is an important factor in a computer’s performance. The more RAM a computer has, the greater it’s ability to “multi-task.”

If you think of RAM as desktop size, this makes sense - a large amount of RAM is like having a very large desk – it holds more!

RAM also affects how quickly a computer will start up and how fast it will let you work, since start up and work speed depend on the ability of the RAM to hold several programs open and running simultaneously.
Instead of being in your mind, the memory in your computer is held on DIMMs (dual in-line memory modules).

DIMMs are complex circuit boards that are installed inside your computer.

When you upgrade the memory in your computer, you are adding more DIMMS to the circuit board to increase your RAM.

All of the hardware we have been discussing - the CPU, the hard drive, and the RAM, are hooked up to a central circuit board, called the motherboard, connected to a power supply and a fan for cooling (because the small microprocessing chip generates a huge amount of heat) ...

and held together in place inside the case or tower...
much like a car chassis holds the parts of a car in place.

That’s some of the hardware associated with the “guts” of the computer. But there are other hardware elements that are external to the actual case that are also important.

Any piece of hardware that is external to the central case is called a peripheral. These can include anything from keyboards to cameras.

Peripherals are generally plugged into the computer, and some are also plugged into an external source for additional power. More and more peripherals are now “wireless” and can align with a computer without any physical wired connection.

Laptops generally have fewer peripherals in their standard set up, though they can accommodate most peripherals as well as a desktop. You can add an extra screen or keyboard to a laptop as a peripheral if you connect them.
Peripherals are generally plugged into the computer, and some are also plugged into an external source for additional power. More and more peripherals are now “wireless” and can align with a computer without any physical wired connection.

Laptops generally have fewer peripherals in their standard set up, though they can accommodate most peripherals as well as a desktop. You can add an extra screen or keyboard to a laptop as a peripheral if you connect them.

On the laptop, you will see ports on both the right and left side of the computer.

The most common type of plug and port, which are now being used for more and more devices, is the USB connection (Universal Serial Bus). The term “BUS” stands for binary unit system, the system of measurement used for computer information. Many laptops have several USB ports, and they can be used interchangeably for any USB plug. Many desktops now have one or more USB ports on the front of the case to make it easier to plug in external devices.

Most of the common peripherals, with
the exception of printers, use USB plugs. If you look at the plug on the end of your mouse, you will see it is a USB plug.

USB ports are interchangeable. That is, if you have a USB plug on a peripheral device, you may plug it into any of the USB ports on your computer.

Another important style of port and plug to be aware of is the power plug. On most laptops, this is a small, round metal plug with a single prong in the center. It plugs into a port of corresponding shape.

Now that we’ve discussed some of the key hardware parts of the computer, we are going to look at the systems that allow the computers to run and perform specific tasks.
Software

Software is the entire set of programs and procedures associated with a computer. You can think of software as “instructions” rather than the “physical parts” of hardware.

Software comes in two forms:
- Operating system software
- Applications software

These systems are known together as “software.” In contrast to hardware, they are not physical elements, but rather the entire set of programs associated with a computer.
You might think of software as sets of directions, that tell the hardware how to operate and what to do.

We distinguish between two kinds of software:
Operating system software and application software.

Operating System (OS) Software

- Operating System, or “OS,” software, is what lets the computer run by setting up the work space environment in which tasks are performed.
- You can think of an OS as similar to electricity in a house or blood in a body – both are larger systems needed to undertake any operation.

Application Software allows you to do different kinds of work in your workspace.
Application software can be compared to a blender in your kitchen or your eye – both designed to perform specific tasks, rather than for keeping the entire system running.
Application Software, or Programs

- **Application Software** allows you to do different kinds of work.
- Application software can be compared to an appliance in your kitchen, such as a blender, which is designed to perform specific tasks. Like appliances, each software application allows you to perform different tasks.

**Operating System**, or “OS,” software, is what lets the computer run by setting up the work space environment in which tasks are performed. You can think of an OS as similar to electricity in a house or blood in a body – both are larger systems needed to undertake any operation.

**Application Software** allows you to do **different kinds of work** in your workspace.

Application software can be compared to a blender in your kitchen or your eye – both designed to perform specific tasks, rather than for keeping the entire system running.
Operating Systems vary, but they all do the same thing—allow the computer to run.

The OS for most non-Macintosh computers is Microsoft Windows. Recent versions of Windows include Vista, XP, and the newest, Windows 7.

Most new computers come with an operating system already installed, so you do not have to worry about loading it on a computer.

Application software is Designed to help users perform particular tasks, such as word processing, spreadsheets, or creative computer painting.

Word, Excel, PowerPoint, and Paint are all examples of application software.

Application software is sometimes referred to as software applications, applications, or programs.

Application software must either be purchased (as Microsoft Office Suite, which includes several software programs) or downloaded from the Internet (usually for free) and installed.
So – to recap the difference between operating system software and application software:

- Both are sets of instructions in the computer that allow it to operate
- OS software is broader and more general in scope – it creates the overall work environment on the computer and the interface between the computer and the user.
- Examples of OS software is Microsoft Windows.
- Application software if more specific in scope – each application creates the ability to perform specific tasks and create specific products.
- Example of application software is Word or Excel.

And – to recap the more general differences between the elements of the computer that we have reviewed in this module –

- **Hardware** constitutes the physical components of a computer.
- Significant internal hardware include the CPU, the hard drive, and RAM.
- External hardware, called peripherals, are also common in computer use.
- **Software** constitutes the set of instruction on a computer.
- There are two kinds of software – operating system software and application software.
- OS software creates the general interface environment.
- Application software creates the tools for specific tasks, or applications.
Video model for trainers

Please see Demonstration training video for this module contained on the flash drive accompanying this toolkit.

Model video - Basic Computer Skills - Module 1
BASIC COMPUTER SKILLS – MODULE 1
Hardware
Definition:

- Central Processing Unit (CPU)
- Hard drive
- Random Access Memory (RAM)
- Ports and Peripherals

Software
Definition:

- Operating System (OS)
- Application Software
BASIC COMPUTER SKILLS
MODULE 1 - ASSESSMENT

1. The type of computer that has a keyboard, monitor, and mouse built into a single unit is called a
   a. desktop  b. laptop  c. bigtop

2. The computer hardware part that determines the speed at which calculations are made is called the
   a. RAM  b. microprocessor (chip)  c. hard drive

3. The computer hardware part which determines how many different programs and files you can have open at one time is called the
   a. RAM  b. microprocessor (chip)  c. hard drive

4. The computer hardware part on which we store images and text is called the
   a. hard drive  b. monitor  c. CPU

5. The computer hardware part on which we view images and text is called the
   a. keyboard  b. monitor  c. port

6. We can interact with the information on our screen by using the
   a. mouse and keyboard  b. hard drive and RAM  c. port and dock

7. The additional external hardware items we can add to our computer, such as printers or scanners, are collectively called
   a. ports  b. mice  c. peripherals

8. The most common type of port on a computer is the
   a. CPU port  b. ABC port  c. USB port

9. Operating system software helps us
   a. perform specific tasks, such as word processing.
   b. set up the overall requirements for the computer.
   c. run our kitchen blenders.

10. Application software, or programs, helps us
    a. perform specific tasks, such as word processing.
    b. set up the overall requirements for the computer.
    c. run our kitchen blenders.
BASIC COMPUTER SKILLS – MODULE 2
Introductory basics, keyboarding and mousing skills

Summary, challenges, and instructional strategies
This module initiates students into using the computer. It introduces key beginning tasks such as turning the computer on and off, identifying key elements of the operating system interface, such as the desktop, icons, and taskbar, and helps them to understand the role of the mouse and keyboard and how to use these tools. They practice basic skills such as orienting to the computer’s screen and desktop, understanding different elements of the screen, and using the mouse to click and double-click.

Assist students with this orientation by providing key elements on which to focus – desktop, icons, taskbar – and repeating these three elements each time they go back to the opening screen. Help students who may have no experience with the mouse, the keyboard, or both, by providing demonstrations, handouts, and one-on-one assistance. Emphasize that these skills take time to learn and reassure them that they will improve with each use. Keep keyboarding exercises simple and provide sample document (loaded onto computers beforehand) to edit for those who do not have typing skills. Move to hands-on mousing exercises quickly – these allow novices to begin practice right away while also providing higher level challenges for those with more skill. Assist with double-clicking by creating sounds that allow them to hear the speed of the clicks and performing clicks together with your hand on top of the student’s.
New Mexico Broadband Program
Basic Computer Skills
Module 2
Introductory basics
Keyboarding and Mousing Skills

These are the skills you can expect to come away with at the end of this class. You should have acquired some basic computer operating skills – how to turn one on and off, how to treat a computer – and also have developed some mousing and keyboarding skills. Mousing and keyboarding take a long time to master, but you should feel that you have made a good start in these areas by the end of the class, and that you know how to follow up and gain more practice in both.
So let’s get started. In order to begin learning about using a computer, we need to know how to turn one on. How do we turn on a computer?

To open a laptop, you will need to find the latch on the front edge of the computer. Slide or press that latch and lift the top of the laptop from the front end. It is hinged on the back end and will swing, or unfold, open. Look for the power button. It is above the keyboard in the upper right hand corner or the center.
Finding the power button on a desktop is easier. It is right on the front face of your computer unit or tower. Again, look for the power symbol. Turn on the computer by pressing the power button firmly. Hold it down very briefly – don’t “punch” the button quickly.

Watch the monitor. You will see movement on the screen as the operating system engages. This process is called “booting up.” Your screen may also be dark during part of this process.

While we’re waiting for the computer to turn on fully, let’s consider how to treat a computer. Computer treatment is pretty straightforward, but it’s worth reviewing. Perhaps the most important rule for proper treatment of a computer is to keep beverages away from it. This is especially true of laptops, in which the important hardware and electronic elements are placed directly below the keyboard. This means that if you accidentally spill liquid on your keyboard, the liquid can run through to the hardware and wiring and ruin the
internal components. To avoid this, make it a habit to place drinks on a different surface than that on which you have placed your computer. Make sure that if the liquid were to spill, it would not get on the computer.

It’s also important not to put objects on top of the keyboard. Again, this is especially true for a laptop, and even more true for a tablet computer. Constant pressure and weight can ruin the keyboard or touchscreen functions.

For non-tablet style computers, the display screen will last longer if you do not touch it. Do not put your fingers, pens, pointers, or other objects, against the screen.

When cleaning the screen, make sure to do so with a computer screen cleaner and an optical grade cloth. Never use chemical cleaners or spray liquids on your computer screen.

It goes without saying that one should never insert anything into the computers’ ports except plugs from computer peripheral devices! Ports often have delicate wire receptors that are easily damaged or crushed by pressure from even a soft object.
Sun can be damaging to a computer, both to the guts that are housed inside the case or tower and to the monitor screen. Temperatures and radiation from sun rays can cause overheating and damage to sensitive computer components. For laptops, in which hardware and electronic wiring is located directly beneath the keyboard, even sunlight on the keyboard can be damaging to the computer. Keep curtains and shades adjusted so that no direct sunlight will fall on your computer at any time during the day. If you have a laptop and like to work outside, make sure it is safely out of the sun.

Magnets can also damage computers. Since much of the computer’s hardware is made up of metal elements and electronic devices, a magnetic field can magnetize the metal components and disrupt the electromagnetic functions of electronic devices. Keep small magnets away from computers. If you work in an area that uses strong magnets (scientific or medical research facilities would be an example), consult your place of business before bringing a computer into the facility.
Proper Treatment of a Computer

The computer should be turned off by closing all the software before turning off the power. You should try to avoid turning off a computer by pressing the power button. We will review the correct way of turning the computer off later in this module.

Since we just turned the computer on by pushing the power button, it is a good time to point out that the same process is NOT used when we turn off a computer! Computers like to be shut down in a certain sequence, just as a car should be put into “Park” before we turn off the ignition.

When you turn off a computer, it’s best if you can close all the software applications before turning off the power. For that reason, we try to avoid turning off the computer by pressing the power button, even though that was the way we turned it on. We’ll show you the proper way to turn off the computer later in this module.

However, if you are ever unable to close the software successfully, you have the option of turning off the computer by pressing the power button, holding it down for over 5 seconds, and releasing it when the screen turns dark.

Basic Computer Navigation

To use a computer, you will work with three tools:

• The screen, to observe information
• The keyboard, to enter information
• The mouse, to move around the screen, initiate actions, and deliver commands.

Even though a computer is a single device, we need to know how to use three separate elements of the computer in order to work with it successfully. The three elements are:

• The screen, or monitor, to observe information
• The keyboard, to enter information
• The mouse, to move around the screen, initiate actions, and deliver commands.
Remember, in a laptop, all of these components are built in. The mouse is replaced by a touchpad. You can also plug in an external mouse or even an external monitor to use with a laptop. Some people do this because they find a mouse easier to use than a touchpad, or because they need a larger screen for some of their computer work.

First, we’ll learn how to use the mouse. The mouse allows you to interact with the information on the screen, to move to different places on the screen, and to type information and commands into the computer.

The mouse works hand in hand with the computer screen and requires manual dexterity as well as hand-eye coordination. This can take a while to learn, so don’t be discouraged if you are just beginning and using a mouse is difficult. Learning any new skill takes time and practice. With a little bit of regular practice for a few weeks, using a mouse will become easy.

Those who have hand injuries, arthritis, or similar limitations may prefer using the touchpad. The touchpad requires a different kind of motion that is easier for those with limited joint or finger movement.
Positioning your Hand on the Mouse

How to position your hand
1. Place your right index finger here.
2. Place your right middle finger on this button.
3. Use your index or middle finger to move the wheel up and down.
4. Rest the palm of your hand on the lower part of the surface.
5. Your right thumb goes here.
6. Your right ring finger goes here.

Everyone holds the mouse a bit differently. Here are the general positions for your hand and fingers on the mouse.

(Instructor – click to display number, click again to display the text associated with that number. Click through for six numbers.)

Take some time to become accustomed to moving your mouse around on the table or desk surface. Hold your mouse lightly on the sides and do not press down or click any of the controls. To move the mouse, gently slide it across the table surface. There is no need to turn or lift the mouse.

Instructor – showing the students how to slide the mouse by demonstrating on the board in the front of class helps a lot.
Remember – you only need to slide the mouse, not turn it.

Make sure you have enough room on your desk or table top to move the mouse well.
As you move the mouse across the desk surface, you will see a white arrow move across the screen. This arrow is called the cursor.

(Instructor – demonstrate this by sliding the mouse on the board in front of the class while projecting your computer screen. To do this, you will need to jump from the PPT presentation to your computer screen. This will allow students to see the correspondence between your hand and mouse movements and the movement of the cursor on the screen.)

As you slide your mouse on the table, look for the position of cursor on the screen as you move the mouse on the table.

This will show you how the movement of the mouse is changing your location on the computer screen.

Practice moving your mouse so that the cursor goes to all four corners of your computer screen.
Although the cursor we see now looks like an arrow, it will often change its shape, depending on the tasks it is doing. For example, if you are exploring a document or website that has a link (a shortcut to another place on a website), the cursor will change into a hand. We’ll see the cursor change to a hand in our mousing exercises.

When we use the cursor to enter a section of text, as we do when we edit a document or create a powerpoint presentation, the cursor changes to a blinking line. We call this the flashing “I” beam, since it resembles the steel I-beams used in construction.

(Instructor – you can demonstrate this by exiting slide show mode and inserting your cursor into the text of a powerpoint screen.)

So – just to review the cursor indicates:

- where your mouse pointer is
- where any text you type will appear
- where you will interact with the information on your screen
Now let’s use your mouse to explore your desktop.

First, we will explain what the “desktop” of a computer is.

On a computer, the desktop is what appears on your screen after you’ve turned on the computer but before you have opened any programs.

The desktop in Windows 7 includes the Start button in the lower lefthand corner, a taskbar along the bottom of the screen, various small images, called icons, arranged in the around your screen.

(Instructor – you can move to the next slide as you read this information and point it out.)
On a computer, the desktop is what appears on your screen after you’ve turned on the computer but before you have opened any programs. The desktop in Window 7 includes

- the Start button in the lower lefthand corner
- a taskbar along the bottom of the screen
- various small images, called icons, arranged in the around your screen.

The taskbar provides you with quick access to programs that you use most frequently. Icons to programs that appear on the taskbar are shortcuts to these programs. Shortcuts on the taskbar can be opened by moving your mouse over the icon on the taskbar and left clicking with your left mouse button.

Let’s practice left clicking with the mouse by opening icons on the taskbar. (Instructions on next slide).
Instructor – you may want to go to your own desktop now and go through the motions described here as you read the text:

To left-click on an image, word, or icon:

First move your cursor over the object on your screen by moving your mouse until the cursor is in the right position. The cursor should be directly over the object.

Next, firmly but quickly press and release the left mouse button once. Keep your hand steady on the mouse to hold it still while you click, using only your pointer finger to depress the left-click button.

The icon on your taskbar should open into a window that fills or partially fills your screen.
When an icon is opened, it will open a “window.” The window will fill your screen with a webpage, a program page, or a file.

Notice that in the top right hand corner of your screen, there are three buttons.

• These are the **minimize**, **restore**, and **close** buttons.
• You will see them in the top right hand corner of almost all the computer or Internet pages you open.

( Instructor – go back to your computer screen and demonstrate how to do this by opening and closing icons from the Taskbar several times. Then have students do this. Remind them to stay with the icons on the Taskbar.

Some windows may open at a smaller size. Explain to the class that we will discuss this shortly.

For the present, simply have them practice opening and closing windows.
Slide 33

Practice Activity

Opening and closing icons on the Taskbar.

Slide 34

Double Clicking

- Another important action you will perform with your mouse is the double-click.
- When we talk about the double click, we are always referring to a double left-click.
- A double click requires two left clicks in rapid succession at the same location.
- When you double click, make sure that you hold your mouse still so your cursor remains in the same place for both clicks.

Slide 35

Icons

- Icons are small images on your desktop that indicate shortcuts to a file or a website.
- Shortcuts provide direct access to a files, programs, or web locations. Without these shortcuts, you would need to search on the Internet or on your computer for specific websites or programs.
- Icons on the desktop can be opened by moving your mouse to the icon and double-clicking (clicking quickly two times) on your left mouse button.

(Instructor – you might want to go back to the slide showing the desktop and point these out as you read this text.

Now let’s go back to the desktop and consider the icons that are on the desktop. Icons are small images on your desktop that indicate shortcuts to a file or a website. Without these shortcuts, you would need to search on the Internet or on your computer for specific websites or programs. They can be anywhere on your desktop and you are the one who adds or removes them from this location.
Icons on your desktop can be opened by moving your mouse to the icon and double-clicking (clicking quickly 2x) on your left mouse button.

Instructor – you may want to go to your own desktop now and go through the motions described here as you read the text:

To double-click on an icon on the Desktop:
First, move your cursor over the object on your screen by moving your mouse until the cursor is in the right position. The cursor should be directly over the object.

Next, firmly but quickly press and release the left mouse button twice. Keep your hand steady on the mouse to hold it still while you click, using only your pointer finger to depress the left-click button.
Practice Activity
Opening and closing icons on the Desktop with a double click.

(Instructor – go back to your computer screen and demonstrate how to do this by opening and closing icons from the Desktop several times. Then have students do this. Remind them to stay with the icons on the Desktop.

Let’s practice double clicking by opening some of the icons on our desktop. Notice that double clicking is much more difficult than single clicking. Getting the two clicks close enough together can be a challenge at first.

What happens if you don’t double click but only single click an icon on the Desktop?

What happens if you don’t double click but only single click an icon on the Desktop? The icon is highlighted, but does not open. Try left-clicking an icon on the desktop. To undo the highlighting around an icon, move your cursor into an empty area on the desktop and left-click once. You can also undo highlighting on one icon by clicking on a different icon. But to open that icon, we need to double click.

Remember – begin by moving your mouse until the cursor is in the location you desire. The icon should be highlighted. Then left-click once.
Slide 40

Double Clicking
While a single click highlights an icon, a double click opens it and takes you to a website or a file.
You can think of the single click as a knock and a double click as a kick. One alerts us that someone is at the door. The other pushes the door open!!

Slide 41

Dragging and dropping
• We also use the mouse to perform an action called drag and drop.
• Dragging and dropping is used to move an item from one place to another, on your screen or in a document.

Slide 42

Dragging and dropping
Place your cursor over the icon and left click. Do NOT release the button. Keeping left button depressed, slide your mouse sideways to move cursor and object. When icon is correctly positioned in new location, release left button.

To practice dragging and dropping, follow these instructions.
(Instructor – you should go to your computer screen now and demonstrate this as you read the text below)

First, place your cursor over the item you wish to move.
Next, press down your left mouse button as you would if you were clicking – but this time, do not release it.
While keeping the button depressed, drag your cursor to the new location. When you come to the place to which you want your item moved, release the
left mouse button by lifting your finger. The icon will now be in the new location.

Use the icons on your desktop to practice dragging and dropping. Use the four steps - PLACE  HOLD  DRAG  RELEASE- to move icons across your desktop. Practice this skill in conjunction with double-clicking to open an icon and closing the application using the close button.

(Instructor – go back to your computer screen and demonstrate how to do this by opening and closing icons from the Desktop several times. Then have students do this. Remind them to stay with the icons on the Desktop.

Some windows may open at a smaller size. We will discuss this shortly. For the present, simply practice opening and closing windows.

Notice that double clicking is much more difficult than single clicking. Getting the two click close enough together can be a challenge at first.
What happens if you don’t double click but only single click an icon on the Desktop?

One other important skill you will use the mouse for is navigating up and down, or left and right, across a window. For this, you will use scroll bars. Scroll bars are used to give the user access to a document that is larger than the window.

Scroll bars appear on the bottom and right edges of your window. Sometimes, they are quite faint. You can move up and down, or sideways, by clicking on the arrows at the end of the scroll bar. You can also click and drag the box in the scroll bar to move more quickly.

Instructor: Go to your computer
screen, open Word or Excel from the Taskbar, and demonstrate the scrollbars.

We will be practicing using scrollbars in our mousing exercises.

Slide 47

Review

- Single left-clicks can highlight icons and open icons on your Taskbar.
- Double left-clicks open icons on the desktop.
- The red close button in the top right closes a window.
- Scrollbars allow you to move up and down within a document or website.
- Dragging and dropping allows you to move information from one location to another.

Slide 48

Computer Keyboards

Before we begin practicing these skills some more, we need to take a moment to look at the computer keyboard.

Single left-clicks can highlight icons and open icons on your Taskbar.
Double left-clicks open icons on the desktop.
The red close button in the top right closes a window.
Scrollbars allow you to move up and down within a document or website.
Dragging and dropping allows you to move information from one location to another.

Before we begin practicing these skills some more, we need to take a moment to look at the computer keyboard.
Remember - the keyboard and the mouse are both important tools for interacting with the computer. We do not need to know how to type much to use a computer keyboard. We can still learn the location of important function keys.

Refer to your handout and the classroom slides as we point out several important keys on the computer keyboard.

Escape key – cancels an action or allow us to exit a full screen when the close button is not showing
Delete key. Erases forward (right) from the location of our cursor
Backspace key. Erases backwards (left) from the location of our cursor.
Enter key – Enters commands or moves to the next line of text. Allows us to start a new line or paragraph when we are typing
Caps lock allows us to type in all capitol letters. Press once to set for capitols. Press again to reset to lower case.

Shift – this allows us to type in capitols only for as long as we hold the shift key down. Used to capitalize a letter at the beginning of a sentence.

Space bar – This creates a blank space in a document if we are typing text. We can use it to move forward in a line of text or on a page.

Arrow keys – These keys allow us to move up and down, or right and left, in a document or on a page, one space at a time. On a website, they can provide a very slow scrolling capability.

Use the following links to practice using your mouse:

http://www.pbclibrary.org/mousing/intro.htm

http://www.seniornet.org/howto/mouseexercises/mousepractice.html

http://www.pbclibrary.org/mousing/games.htm

Instructor- You may want to insert these on the desktops of the computers the students are using before class begins.
Typing practice

Use the following links to practice your keyboarding and typing skills:

- http://typing-lessons.org/

Instructor- You may want to insert these on the desktops of the computers the students are using before class begins.

Turning off your computer

Follow these steps to turn off a computer correctly.

1. Close all windows.
2. Click on the Start Button
3. Click on Shut Down.
4. Wait for computer to power down.
5. Turn off monitor or close.

Follow these steps to turn off a computer correctly.

1. Close all windows.
2. Click on the Start Button
3. Click on Shut Down.
4. Wait for computer to power down.
5. Turn off monitor or close.
Let’s review what we have learned.

- Turn on and off a computer
- Proper care of a computer
- Using a mouse and cursor
- Desktop, Taskbar, icons
- Single and double clicking
- Scrolling
- Closing a window
- Important keyboard locations

We appreciate the time you spent with us. We hope to see you at the next training!

These materials were created collaboratively by the New Mexico Department of Information Technology, Fast Forward New Mexico, and the New Mexico State Library, under grants provided by the National Telecommunications and Information Administration. These materials are not to be used for profit.

Connecting you to a world of opportunities

Demonstration training video

Model video - Basic module 2
Terms to know and be able to define or identify:

**Power button** – Button with universal symbol used for turning the computer ON.

**Cursor** – Pointer that appears on your screen and moves with the movement of your mouse. The cursor can change shape, depending on where it is and what type of material (e.g. text or link) it is moving over.

**Mouse** – The handheld device used to interact with a computer screen.

**Desktop** – The screen that appears on the computer once the operating system is running.

**Start button** – In Windows 7, it is the round multi-colored button in the lower left hand corner of the desktop.

**Taskbar** – The band that runs along the bottom of the desktop and contains icons.

**Icons** – Images on the desktop and taskbar that provide shortcuts to programs and websites.

**Close button** – The red button with the white “x” in the upper right hand corner of the screen.

**Single and double clicks** – used to open icons and links. A single click will open icons on the Taskbar and links; a double click is used to open icons on the desktop.

**Drag and drop** – A process using the mouse that allows you to move items (files, icons) from one location, such as a folder, to another.

**Scroll bar** – A tool provided by browsers and other programs that allows you to view the full length and width of a webpage or document that is not fully visible on the computer screen.
Assessment

BASIC COMPUTER SKILLS
MODULE 2 – ASSESSMENT

1. To turn on a computer, you will
   a. tap the keyboard  
   b. press the power button  
   c. pour coffee on the mouse

2. When you slide your mouse across the desktop, what will happen on your screen?
   a. the icons disappear  
   b. the desktop changes 
   c. the cursor moves

3. An icon is a small image that represents
   a. an error  
   b. a picture  
   c. a shortcut to a file or program

4. To open an icon on your computer, you can
   a. left click it once or twice  
   b. right click it once  
   c. tap the monitor with a pen

5. To close a program window once it is open, you should click on
   a. the Start button  
   b. the Taskbar  
   c. the red, square “Close” button in the top right of the window

6. To move an icon across your desktop, you will
   a. left click once  
   b. click the red close button  
   c. click, hold, drag, and release

7. Scroll bars allow us to
   a. move icons  
   b. move up and down, or sideways, within a window  
   c. write more quickly

8. The backspace key on the keyboard will
   a. enter a command  
   b. erase information typed to the left of the cursor  
   c. go back a page on a website or document

9. We can create space in a document we are typing by using
   a. the Enter key or space bar  
   b. the arrow keys  
   c. the backspace and delete keys

10. The best way to turn off your computer is to
    a. click Start, then Shut Down  
    b. press the enter key  
    c. press the power button
BASIC COMPUTER SKILLS – MODULE 3
Navigating files and working with windows

Summary, challenges, and instructional strategies
This module focuses on navigating windows and locating files and programs. The module teaches students to open and close files, move into and out of folders by clicking icons and using the back button, understand the forward button and breadcrumbs, and find common programs using the Start menu. Students also explore the minimize and restore/maximize button and learn how to move windows by using “drag and drop” techniques.

The chief challenge to instruction in this module is helping students understand and use a virtual representation of something concrete – programs and file locations. The best way to address this challenge is to develop an effective analogy or comparison to help students understand what areas labeled “Documents,” “Computer,” or “Microsoft Office” actually represent. Differentiating, for example, between application software (as tools) and information locations (as file drawers) can help give students broad categories of comparison that will aid their understanding. Repeating these analogies each time the Start Menu, a program, or a document is opened will help reinforce this associative understanding. Providing sample objects for each category (i.e. real tools and real boxes with file folders) can add understanding for spatial or kinesthetic learners. Drag and drop is a difficult skill for novice learners and hands-on assistance, performing the task with both instructor and student hands on the mouse, can be extremely helpful.
New Mexico Broadband Program
Basic Computer Skills
Module 3
• Computer operating skills
• Navigating Windows

Class Goals
• Acquire basic understanding and skills using the Start menu
• Acquire ability to locate, open, and close programs
• Acquire the ability to open, close, and manipulate windows
We are going to explore the organization of information in your computer. Understanding the organization will help you know where to store and where to find your documents and files.

The Start Button
We begin by opening the Start menu on your computer. You will find the Windows 7 Start Button on your desktop in the lower left corner.

The Start Button
You can open the start menu by left-clicking on the button once. Move your mouse until the cursor is over the Start button before you click.
The Start Menu

Opening the Start menu is like opening a cabinet in which you keep all your office tools AND all your office documents.

http://office-turn.com
http://smallbusiness.chron.com

The Start Menu

The Start menu provides an abbreviated Table of Contents for everything in your computer.

The dark column on the right lists major locations on your computer. Think of these as file drawers, in which you store or look for information.

The white column on the left lists application software, or programs, commonly used on your computer. Think of these as the tools you use most frequently.
The four items listed on the top of the File Drawer side are the files that we use most frequently. These are Documents, Pictures, Music, and Videos. Together, they are called the Libraries.

Think of the entire right hand column as the complete filing system for all the information in your computer.

and the libraries as a single drawer that contains your personal files.
Slide 12

**Libraries on the Taskbar**

We can access the libraries individually from the Start Menu, or as a separate group through an icon on the Taskbar.

The icon for the Libraries looks like a set of folders held up by a metal bookend. If you click once on this icon, you will open the Libraries’ drawer.

---

Slide 13

When you open Libraries, you are taken to a set of folders with the same names as the top four terms listed on the right side of your Start menu: Documents, Pictures, Music, and Videos.

---

Slide 14

**Exploring the Libraries**

Open the Libraries by left-clicking on the Libraries icon on your taskbar.

Next, open the “Pictures” library by double clicking on the icon.
Slide 15

Double click on the “Sample Pictures” folder to open it.

To look at a close-up of any picture, double click on the image.

To close any window, such as the enlarged picture, click the red “Close” button.

New Mexico Broadband Program in partnership with Fast Forward New Mexico

Slide 16

Explore each image, then close it.

Remember to use the “Esc” button if you get stuck!

New Mexico Broadband Program in partnership with Fast Forward New Mexico

Slide 17

Suppose you want to now explore the Videos Library next. The back arrow in the upper left hand corner of the screen will help you navigate back to the main Library page, where you can access the Video Library. Each click of the back arrow takes you to the page previously visited.

New Mexico Broadband Program in partnership with Fast Forward New Mexico
The elongated box at the top of the page next to the "Back/Forward" arrows is called the Breadcrumbs. As you click the back arrow, watch the changes that occur in the words in this box.

The Breadcrumbs is a helpful tool for finding your way in and out of files. It helps you keep track of the path between where you are and where you have been!

Practice using the mouse, the close button, the back arrow, and the breadcrumbs to explore the libraries.

More about the Start menu

Let's look at a few other locations listed on the Start menu.
New Mexico Broadband Program in partnership with Fast Forward New Mexico

**Slide 21**

**Computer on the Start menu**

- Space remaining on hard drive.
- Space remaining on removable flash drive.
- Clicking on any one of these icons will open that device.

**Slide 22**

**Computer on the Start menu**

- If you insert a DVD or a CD, you can access it by clicking on Computer. Click on the DVD or CD icon to begin playing.

**Slide 23**

**More about the Start menu**

- Another important item on the Start menu is the Control Panel.
- We use the Control Panel to add a printer or other device, and to adjust settings on the computer.
- If we click on Control Panel, it will take us to a screen that allows us to adjust settings in a variety of areas on our computer.
New Mexico Broadband Program in partnership with Fast Forward New Mexico

**Slide 24**

**Control Panel**
- Add a printer
- Change desktop
- Change display settings

**Slide 25**

**The left side of the Start menu**
- The white column on the left shows the commonly used software programs.
- You may see links to specific programs you use frequently in this list.
- To open a program, click on the words.
- To view a complete list of all the programs used on your computer, place your cursor over All Programs and click once.

**Slide 26**

**Open All Programs**
1. Click on the **Start** button.
2. Click on **All Programs**.
3. Use the scroll bar in the **All Programs** menu to view the range of software programs available on your computer.
Working with Windows

To work with any program or website, you will need to know how to work with windows. These are the screens that open up any time a program or web page is opened.

New Mexico Broadband Program in partnership with Fast Forward New Mexico

Slide 27

Working with Windows

We’ve already learned that windows have three control buttons in the upper right hand corner. We know the red box with the “X” is the close button. Clicking on this button will close the window and the program that you are using.

New Mexico Broadband Program in partnership with Fast Forward New Mexico

Slide 28

Working with Windows

Practice opening and closing some of the programs on the Start menu.

New Mexico Broadband Program in partnership with Fast Forward New Mexico

Slide 29
Slide 30

Windows buttons
The button on the left is the minimize button. Clicking this button hides the window that is open on the Taskbar. The icon on the Taskbar will be highlighted when a window is minimized there.

Slide 31

Working with Windows
Practice opening a program or icon, minimizing it to the Taskbar, opening the window from the Taskbar, and closing it again. You can also open two windows at the same time by opening the programs from the Start menu.

Slide 32

Practice working with Windows
Practice opening, minimizing, and re-opening programs from the Start menu and Taskbar.
Slide 33

Hovering and preview windows

Notice that if you place your cursor over the Taskbar icon that is highlighted, a mini, preview window will appear. If you have more than one window of that program open, you can preview all the windows.

---

Slide 34

Windows restore button

The middle button is the **restore down/maximize** button.

Clicking this button will reduce the size of the window. If the window size has already been reduced, clicking the restore button again will maximize the window to full screen size.

---

Slide 35

Practice working with Windows

Practice using the restore down/maximize button with an open window.
You can also move windows around on your desktop in order to be able to better view multiple windows when they are on your desktop.

To move a window, first use the restore button to reduce the size. Then place the cursor over the top edge of the window.

Hold down the left mouse button and slide the mouse as you drag the window across the desktop.

When the window is where you want it located, release the button.

You can also change the size of windows. To do this, place the cursor in the corner of the screen until it turns into a double arrow.
Slide 39

Working with Windows

Then left click and hold the mouse button down while you slide the mouse around.
The double arrow will change the size of the window inwards or outwards from the corner you are dragging, depending on your movements.

Slide 40

Working with Windows

Practice moving windows around the desktop.
Practice resizing windows using the diagonal resizing arrows.

Slide 41

Practice working with Windows

Practice moving windows around the desktop.
Practice resizing windows using the diagonal resizing arrows.
Slide 42

Review

Start menu
Task bar
Exploring Libraries
Minimize, restore/maximize
Dragging and changing windows

___________________________________
___________________________________
___________________________________
___________________________________
___________________________________
___________________________________
___________________________________

Slide 43

Turning off your computer

Follow these steps to turn off a computer correctly.
1. Close all windows.
2. Click on the Start Button
3. Click on Shut Down.
4. Wait for computer to power down.
5. Turn off monitor or close.

___________________________________
___________________________________
___________________________________
___________________________________
___________________________________
___________________________________
___________________________________

Slide 44

We appreciate the time you spent with us.
We hope to see you at the next training!

These materials were created collaboratively by the New Mexico Department of Information Technology, Fast Forward New Mexico, and the New Mexico State Library, under grants provided by the National Telecommunications and Information Administration. These materials are not to be used for profit.

Connecting you to a world of opportunities

Demonstration training video
Handout

BASIC COMPUTER SKILLS – MODULE 3

HANDOUT

Terms to know or be able to identify
The Start Menu

The Libraries

Back Arrow

Breadcrumbs

Computer on the Start Menu

Control Panel on the Start Menu

All Programs on the Start Menu

Minimize button

Restore down/maximize button

Skills
To open a file, double click on the icon. To close a file, click the red “Close” button.

Use Computer to look at different storage locations (hard drive, DVD, flash drive) on the computer.

Use the Control Panel to adjust settings on the computer.

To open a software application,
1. Click on the Start Menu
2. Click on All Programs.
3. Use the scroll bar in the All Programs menu to view the range of software programs available on your computer.

To move windows, drag the window by the edge of the top of the window.

To resize windows, place your cursor in the corner of the window. Use the double arrow that appears to drag and drop the corner until the window is the size you desire.
Assessment

BASIC COMPUTER SKILLS
MODULE 3 - ASSESSMENT

1. The information that appears on the left side of the Start menu is best described as
   a. a list of tools most commonly used on the computer.
   b. a list that includes the locations of your personal documents and information.
   c. a listing of errors on your computer.

2. The information that appears on the right side of the Start menu is best described as
   a. a list of tools most commonly used on the computer.
   b. a list that includes the locations of your personal documents and information.
   c. a listing of errors on your computer.

3. The Libraries icon on the Taskbar looks like
   a. an old building.
   b. a shelf with books.
   c. a set of folders held by bookends.

4. To open the Documents Library
   a. click on “Documents” on the right side of the Start menu.
   b. click on “Computer” on the right side of the Start menu.
   c. press the power button on the front of the computer or keyboard.

5. Clicking the back arrow in the top left corner of your window once will
   a. take you to the Start menu.
   b. take you to the previous page on a website.
   c. take you to the desktop.

6. The “breadcrumbs” in the long textbox at the top of the window shows you
   a. how to get to the kitchen.
   b. how to get to the Start menu.
   c. the path between your current computer or website location and where you began.

7. If you want to add a printer to your computer, you will need to open which tab on the Start menu?
   a. Control Panel
   b. Documents
   c. Computer

8. The minimize button
   a. closes the window.
   b. decreases the window size.
   c. hides the window on the Taskbar.

9. You can change the size of a window by
   a. using the minimize button.
   b. grabbing the window by the top of the frame and dragging.
   c. using the double pointed arrow that appears when you place your cursor over the corner of the window.

10. You can move a window by
    a. using the minimize button.
    b. grabbing the window by the top of the frame and dragging.
    c. using the double pointed arrow that appears when you place your cursor over the corner of the window.
BASIC COMPUTER SKILLS – MODULE 4

Introduction to word processing

Summary, challenges and instructional strategies

This module introduces students to word processing using Microsoft Word. The session familiarizes students with the key features of the Word interface (the ribbon and the tabs) and teaches skills for creating, editing, saving, and retrieving a document, both on a hard drive and on a portable storage device.

The key challenge for successful instruction of this module is keeping students directed in their tasks and focused on a limited number of tools. While you can give a very quick overview of the various tabs, it is recommended that you work exclusively in the Home tab and that you use a very limited number of commands. More advanced students may move forward to additional tabs and commands on their own, but success for all will be most supported by limiting the number specific tools taught. Helping students recognize the overall pattern of commands in the ribbon areas and understand how commands work (as an ON/OFF switch) will give them confidence, keep them from feeling overwhelmed by the number of specific commands available, and ultimately allow them to use any command successfully.
New Mexico Broadband Program
Basic Computer Skills
Module 4
Using a word processing program
Saving and Retrieving a document

By the end of the class, you can expect to be able to complete those tasks.

What is word processing and why is it such an important skill for everyone to have?
Word processing is a system that allows one to create, edit, organize, save, and retrieve documents easily and quickly. With word processing, you can begin work on a letter or memo in one location.
and finish working on it in another place.
The convenience of use and the professional quality of the product makes word processing a great asset for students, professionals, business people, and anyone working with written documents.
Word processing allows you to create professional quality brochures and invitations, reports and business cards, all from a single program.

Microsoft Word is the word processing program used in most PCs. PC is just the term we now use for a non-Macintosh personal computer. Word is now so universal that they make a version for Mac users as well.

It is one of the programs that you will find in the list of application software when you open the Start button.

You may see Microsoft Word in the list of frequently used programs on the left side of the start menu.
You can always access Word by opening All Programs, using the scroll bar to find Microsoft Office, and opening Word.
Let’s open Microsoft Word. If your computer is not on, take a moment to turn it on and let it boot up. Remember, we turn the computer on by pressing the power button.

Once the computer is on, we will

1. Click on the **Start** button.
2. Click on **All Programs**.
3. Find the **Microsoft Office** folder in the list of programs that pops up. Left click on the words “Microsoft Office.”
4. Select **Microsoft Office Word** from the list of programs that shows up by left clicking on the words.

When you first open Word, a blank document appears on the screen, waiting for you to type onto it. But there is more on your screen than just a blank piece of paper. Above it there are symbols and letters, and along the side there is a scroll bar.
This program has a layout that is common to other programs in Microsoft Office, such as Excel and PowerPoint.

To understand Word, we will begin by understanding this layout.

The Microsoft Office Suite programs, including Microsoft Word, share these common features:

• The File tab, through which files are accessed and saved.
• The ribbon, which is the band on the top of your screen, and
• The standard windows buttons in the upper right hand corner of the screen that allow you to close, minimize, and restore the window.

There are also a series of tabs that run along the top of the Word ribbon. Each tab focuses on a particular kind of task that you might use in Word processing. Insert is for inserting images and tables, Page Layout is for setting margins, creating columns, or changing page color, Mailings is for sending mass mailings or printing envelopes and labels, and references allows you to format tables on contents, footnotes, and much more.

The tab that Word opens to is the Home Tab. This tab contains the basic
commands that you use most frequently in most word processing tasks. Our work today will keep us in the Home Tab, but it's important to realize that this single program has much more capacity than what we will see today.

Begin by creating a simple document. To do this, place your cursor in the "paper," left click to enter the page, and start typing.

Type whatever you like. It does not have to make sense. You can copy text from a handout or you can type the same letter over and over. If you do not know how to type and you'd like to start learning, find the letters of your name and practice typing that again and again.
As you type, you will notice some activity on your screen, aside from the letters that you are putting down.

- Red underlining may appear. This indicates a possible spelling error.
- Green underlining indicates a possible error of grammar, spacing, or sentence structure.
- Blue underlining indicates an error in usage.

Remember that even though the computer may think there is an error, this doesn’t mean that there is. The computer is only as smart as the people who program it. It does not, for example, recognize foreign and proper names, understand complex sentence structure and word usage, know many terms related to computers.

We can use these tools as aids, but should not be discouraged or guided by what the computer thinks. As you type, you may want to begin a new line. The computer will begin one for you automatically when the current line is full. If you would like to begin a new line before then, use the Enter key. You can skip one or many lines using the Enter key.

You can use the space bar to create room between words, ideas, or sentences. The space bar allows you to save room for a word or name that you may not know how to spell or may not remember offhand.
Often when we type, we make errors, change our mind about what we want to say, or unintentionally hit a button that erases an entire paragraph. When these things occur, it can be helpful to know about the **Undo** button.

The undo button is in the top left corner of your ribbon. The undo button will undo typing, erasing, spacing, and all other work that you may want to take back.
Sometimes, when we type, we do not want to undo an action as much as we want to correct a choice of word or insert a new phrase. These editing changes all require that we go back into the text we have been creating and make those changes.

We can do this easily in a Word document.

To add text, simply place your cursor at the point in the text at which you wish to make the changes, such as adding a word, erasing a letter, or any other simple editing tasks. Left click once. You should see the “flashing I” of your cursor. Type the text you want to add. Note that the text is inserted at the point of your cursor. When you are done, you can place your cursor back in the section at which you were working and continue your document.
To erase text or punctuation, you will begin the same way. Place your cursor at the point at which you want to erase text. If your cursor is placed to the left of the text you want to erase, use the Delete key to erase.

Remember, the “Delete” key erases information in front of the cursor, one letter at a time.

The “Backspace” key erases information behind the cursor, one letter at a time.

So if your cursor is placed to the left of the text you want to erase, use the Delete key to erase.

If your cursor is placed to the right of the text you want to erase, use the backspace key to erase.
Practice inserting and erasing text in your document.
Use the undo button as well.

Suppose we want to use some of the tools available through the ribbon.
How do we figure out what the symbols and icons in the ribbon mean and how do we use these tools?

The commands are organized in a way that helps us understand their use.

The commands are placed within groups of similar commands.

Let's focus on the command groups in the Home Tab.
The Home Tab ribbon contains the commands most often used in Word.

The names of the groups appear under each grouping and indicate the general area of the command group. We'll review a few of these so we can understand the general organization.

Copy, Cut, Paste and Format Painter are the commands within the Clipboard group. Instructions for using these commands are provided in a separate handout.
The second group of commands on the Home ribbon is the Font group. The font group commands are format enhancing tool that includes font typefaces, font size, font effects (bold, italics, underline, etc.), colors and more.

You can preview how the new font will look by highlighting the text, and hovering over the new font typeface.

The third group on the Home ribbon is the Paragraph group. The paragraph group allows you to change Paragraph Alignment (left, right, centered, or justified), adjust Line Spacing within a paragraph, adjust spacing before and after paragraphs, along with working with paragraph Indentation. This is also the area where you can add bullet lists, number lists, or outline form to a document.

The fourth group on the Home ribbon is the Style group. Styles are a collection of formatting options that you can apply to text. When you use styles to format your document, you can quickly and easily apply a set of formatting choices consistently throughout your document.

A style is a set of formatting characteristics, such as font name, size, color, paragraph alignment and spacing. Some styles even include borders and shading.

The Fifth and final group on the Home ribbon is the Editing Group. The commands in the Editing group are Find, Replace, and Select. When you create a document in Microsoft Word,
you may decide to change a certain word or phrase that is repeated throughout the document. Let the computer do the hard work with the Find and Replace feature in Word, and you can be sure you didn't miss one.

Most commands are simple buttons and function as on/off switches. Click the button once and that command will be active. This means that anything that you type in your document will be affected by that command. When the command is off, it will be surrounded by blue and look like all other commands. When a command button is on, it will be surrounded by orange. A command will only work when it is on. In order to have a command apply to the text you are typing, you must click the button to turn on the command first. To stop the application of the command to the text you are typing, you must click the button again to turn the command off.

In the above illustration, Bold is an example of a button, shown above first off, then on.
To turn the command off, so that it no longer applies to what you type, click the command button again.

If you aren’t sure what a command is or what a command does, place the mouse pointer over the command and hold it there but do not click. This is called “hovering.” A text box will open up. The text box contains the command name and the keyboard shortcuts for the command, along with an explanation of the command.

Use several of the commands in the Font Group of the Home Tab as you create your document. Try using new font styles, sizes, and text colors. Try using the bullets and numbering commands in the paragraph group.
Practice using commands in your Word document.

Now that you've created a document, you need to know how to save it. Position your cursor over the File tab and left click. A list of options will appear. Move the cursor down to “Save As” and click.

Once you click “Save As,” you will be taken to a Dialogue Box.
- Dialogue Boxes are the points at which you choose options.
- The “Save As” Dialogue Box is used to save your document in the best way.
To save a document, you will first need to give your new document, or “file,” a name. We use the word “file” to refer to any type of item that is stored on a computer. So documents are considered files, but so are photos, videos, PowerPoint presentations, and even music.

Look for the long box near the bottom of your screen that appears after “File name.” This kind of box is called a textbox because you can type text into it.

Note that the computer has already given your file a name and highlighted it in blue.

The name it chose was the first sentence of your document.

Since the first sentence is not generally a good name for a file, we want to erase this and create a good name for the file.

File names should

• identify the document clearly to you.
• be descriptive of what is in the document so that you will understand the contents from the name.

Putting a date in the name can also help you identify it.
Type your file name into the text box.
Do not leave blank spaces.
Use only periods and dashes as punctuation.
If you put a date in the file, make sure you do not use any slashes (3/2/2010). Your file name will be rejected if you do, and you will receive an error.
File names should identify the document clearly to you. They should be descriptive of what is in the document.

Putting a date in the name can also help you identify it. If you put a date in the file, make sure you do not use any slashes (3/2/2010). Your file name will be rejected if you do, and you will receive an error message.

When you have decided on the name, type your file name into the text box.

Because the old name is highlighted, if you just begin typing, the old name will be erased and the new one will appear in the textbox.

• Do not leave blank spaces.
• Use only periods and dashes as punctuation.
• Remember - if you put a date in the file, make sure you do not use any slashes (3/2/2010).
Lastly, you should check the “file type” for your new document.

Your computer usually suggests the correct file type for the format you are using, but always check.

Since we created a “Word Document,” the file type suggested is a Word Document.

Once you have saved your file, Word automatically takes you back to the document.

If you add more information to your file, you must be sure to save it again; otherwise, you will only have the early version saved. If you keep the file name the same, Word will automatically replace your old version with the newer one.

Practice saving your file on your computer.
If you add more information to your file, you must save it again; otherwise, you will only have the early version saved and the additions and changes will not be stored.

Even though word “updates” your document every few seconds as you type, it will not save those changes onto a stored version of your document unless you tell it to do so by saving again.

If you keep the file name the same, Word will automatically replace your old version with the newer one when you save it again.

Never close a file until you have saved the changes you have made.

When we are not able to finish a document, or may not come back to the same computer to continue our work, we need to save our files on something other than the hard drive of that computer.
For this, we use a portable storage device. The most common portable storage device is a “flash drive.”

Flash drives are sometimes referred to as thumb drives.

They are also known as USB drives (because they have a USB plus) or jump drives (because they allow you to jump from one computer to another with your files). All these terms refer to the same device.

Jump drives are replacing CDs as the preferred mode of portable storage. While they are not as permanent as CDs, they do

Flash drives are replacing CDs as the preferred mode of portable storage. While they are not as permanent as CDs, they do allow us to transfer information from one computer to another quickly and easily.

Think of a flash drive as a briefcase. It allows you to carry the work you need with you.

Some peripherals, such as printers, can be hooked up to receive and use information directly from a flash drive.
We are now going to save a document to a flash drive.
To do this, you will first need to insert the flash drive into your laptop.

Locate the USB ports of the right side of your laptop.

Take the top cap off the drive, align it to match the port interior, and gently but firmly push in into the port. If it does not fit, make sure the drive is oriented properly.

Next, follow the same first steps that you used to save your file to the hard drive.

Click on the File Tab and scroll down to “Save As.” Left-click once.

When the dialogue box opens, use the scroll bar on this side menu to move down to Computer and click on Removable Disk. This may also be listed as USB disc or Portable storage device. Sometimes it is listed with the name of the manufacturers, such as Warrior.

This is not the scroll bar for the entire dialogue box, but the one in the middle of the box, directly to the right to the list of computer storage locations. It is difficult to see on the presentation slide but should be easy to see on your computer screen.
Click on the Save button to save your file on the flash drive.

Once your document is saved to the flash drive, you can remove the drive.

To determine whether the saving process is complete, check that no lights are flickering inside your flash drive. If there are no lights on, it is safe to remove the drive.

Hold the sides firmly and pull straight out, wiggling very gently if needed.

Before you close your file, check to see that it is safely stored on your flash drive. If it is, your file should now have the name you gave it when saving.

Look at the very top of the window in which your document is displayed. If you file was saved with the name you gave it, the name should now appear in the center top of the screen.

When you see that your document has been saved with the name you gave it, it is safe to close the document. Use the “Close” button to close your Word document.
In order to use or complete a document, we need to be able to find it once it is saved. How do we retrieve a document?

We know our files are stored in the Documents library, so if we look in Documents, we should find our file.

Remember, you can access the Libraries from the Taskbar. The icon for the Libraries looks like a set of folders held up by a metal bookend. If you click once on this icon, you will open the Libraries’ folder.

When you have opened the libraries, double-click on the Documents Library to open this folder.
Slide 46

The computer will list the Word documents that are created and stored in your Documents library. Select yours and open by double clicking over the words.

Slide 47

If you do not make any changes to the document, you may simply close it and it will be automatically resaved in the original form. Use the close button to close the document.

Slide 48

Practice locating and opening the file that you saved on your computer. Close the document after you have opened it.
What if your file is stored on a flash drive and not in the Documents Library? We cannot retrieve it by going to the Documents Library, because it is not stored there. It is on your flash drive.

First, we need to insert the flash drive into the computer again. Then, we go to the Start menu and open Computer, since this is the location that shows us information about other devices.

What if your file is stored on a flash drive and not in the Documents Library? We cannot retrieve it by going to the Documents Library, because it is not stored there. It is on your flash drive.

Instead, we need to look for it on the flash drive. First, we need to insert the flash drive into the computer again.

We go to the Start menu and open Computer, since this is the location that shows us information about other devices.
Double click on the Removable Disk icon or text to see a list of all the files on the flash drive.
You should see the name of your document listed in the dialogue box.

Select yours and open by double clicking over the words.

If you do not make any changes to the document, you may simply close it and it will be automatically resaved in the original form.
Use the close button to close the document.
Slide 55

Editing a document

Practice locating and opening the file that you saved on your removable disk.
Close the document after you have opened it.

Slide 56

Organizing documents

Computers are very helpful if we can easily locate the material we need quickly and easily.

When our computer gets full of letters, memos, photos, and videos, finding what we want is not always easy.

Slide 57

Organizing your documents

To make sure we can find the information we keep on our computer, we need to organize it well.
When we save a document, we can save it as a file as we have done. But we also have the option of saving those files in folders.

If we look closely at the list of documents in a library, you will see that some are stored as single documents and some are stored in folders.

To organize our documents, we need to sort our files into folders, just as we would for hard copies of documents. To do this, we need to be able to create folders.

To create a folder, open the Document Library and click on “New folder” in the menu bar above the Documents Library listing.
When you do this, a new folder is automatically created and will appear highlighted in your list of documents. Type a name for the folder. It will automatically appear in the highlighted box.

Note that the new folder is ready for typing a folder name. You can tell this because the dark blue highlighting signifies an active box.

Type the name you want to give to the folder into the box. Think about what name will be the most useful!! When you are done naming your folder, press the “Enter” key on your keyboard. The new folder now appears in the list of documents. It is automatically placed in alphabetical order.

If you want to save a file into the folder, follow the same steps that you did when saving to the Documents library. When you open the Documents library, look for your folder.

When the new folder is open, your list of documents will be blank (since the folder is empty!). The folder name should appear in the “breadcrumbs” list at the top. To save your document into the folder, click the “Save” button in the lower right corner.
To save a file to a folder, you must first open the folder. To open a folder, left click once to highlight, then click the "Open" button in the lower right corner.

When the new folder is open, your list of documents will be blank (since the folder is empty!). To save your document into the folder, click the “Save” button in the lower right corner.

When the new folder is open, the folder name should appear in the “breadcrumbs” list at the top. To save your document into the folder, click the “Save” button in the lower right corner.

Practice creating a folder and saving your document in the folder. Close the document after it is saved in the folder.
You can also sort documents into folders by clicking and dragging them into the folder.

To drag a document into a folder, click once over the file name in the documents library. Keep the left mouse button down as you slide the mouse to drag the file into the folder. A textbox will appear under the file as it is dragged. When it tells you it is in the correct folder, release the mouse button. To check that your file was accurately placed in the correct folder, open the folder by double clicking. The file you just moved should appear in the list of items in the folder.

Use this method to sort your documents into folders. You can create as many folders as you need to organize your files.

Practice moving documents into folders on your computer.
Slide 68

Review

Opening a software program
Creating a document
Using ribbon commands
Editing, saving, and retrieving a file
Creating and organizing folders

Slide 69

Turning off your computer

Follow these steps to turn off a computer correctly.

1. Close all windows.
2. Click on the Start Button
3. Click on Shut Down.
4. Wait for computer to power down.
5. Turn off monitor or close.

Slide 70

We appreciate the time you spent with us.
We hope to see you at the next training!

These materials were created collaboratively by the New Mexico Department of Information Technology, Fast Forward New Mexico, and the New Mexico State Library under grants provided by the National Telecommunications and Information Administration. These materials are not to be used for profit.

Connecting you to a world of opportunities

Demonstration training video
Terms to be able to identify or define

Word processing

Ribbon in Microsoft Word

File tab in Microsoft Word

Home tab in Microsoft Word

Enter key

Space bar

Arrow keys

Undo button

Delete key

Backspace key

Command groups

Dialogue box

Removable disk
Skills

Using a command  Commands function like on and off switches. To turn the command on, click on the icon. A highlighted box will appear around the command. Everything you type will be affected by that command until it is turned off. To turn off the command, click the same icon again. When the highlighting is no longer visible, the command is off.

Saving a document

- Position your cursor over the File tab and left click. A list of options will appear. Move the cursor down to “Save As” and click.
- Once you click “Save As,” you will be taken to a Dialogue Box.
- To save a document, you will first need to give your new document, or “file,” a name. Look for the long box near the bottom of your screen that appears after “File name.” Note that the computer has already given your file a name and highlighted it in blue. Create a good name for the file that identifies the document and is descriptive of what is in the document.
- Do not leave blank spaces and do not use punctuation except periods and dashes. If you put a date in the file, do not use any slashes. Check the “file type” to make sure it is being saved as a Word document, then left click once on the Save button.
- To save to a flash drive or other portable storage device, first insert your flash drive into a USB port on the computer. When the dialogue box opens, use the scroll bar on this side menu to move down to Computer and click on “Removable Disk.” This is the flash drive. It may also be listed as USB disc or Portable storage device. Sometimes it is listed with the name of the manufacturer, such as Warrior. All other steps in the saving process will be identical.

Retrieving a document

- Open the libraries folder from the Taskbar. When you have opened the libraries, double-click on the Documents Library to open this folder. You can also open Documents by double-clicking this icon from the Start Menu.
- The computer will list the Word documents that are stored in your Documents library.
- Select yours and open by double clicking over the words.
- If your file is stored on the flash drive, insert your flash drive into the computer.
- Then, go to the Start menu and open Computer.
- Double click on the Removable Disk icon or text to see a list of all the files on the flash drive. You should see the name of your document listed in the dialogue box.
- Select yours and open by double clicking over the words.

Creating a folder

- To create a folder, open the Document Library and click on “New folder” in the menu bar above the Documents Library listing.
- A new folder is automatically created and will appear highlighted in your list of documents.
- Type a name for the folder. The name will appear in the highlighted box. When you are done, press the “Enter” key on your keyboard. The new folder will appear in the list of documents.
Assessment

BASIC COMPUTER SKILLS
MODULE 4 – ASSESSMENT

1. Word processing programs
   a. allow you to make changes easily and quickly.
   b. allow you to work on documents in different places, at different times.
   c. allow you to create professional quality materials.
   d. all of the above

2. You can access Microsoft Word from
   a. the short list of programs on the left of the Start menu.
   b. the Microsoft Office folder listed under All Programs in the Start menu.
   c. an icon on the Taskbar.
   d. all of the above

3. The Home tab on the Word ribbon will show you
   a. the commands most commonly used in Word processing.
   b. the commands related to font size and typeface.
   c. the commands related to line spacing, and bulleted.
   d. all of the above

4. To erase information on a document in Word, you could use
   a. the delete key.
   b. the backspace key.
   c. the undo button.
   d. all of the above

5. When you click a command in the Word ribbon and turn it on, it will
   a. have an orange box around it.
   b. be applied to text you next type or create.
   c. be applied until you turn it off by clicking on the command button again.
   d. all of the above

6. To save a document, you will need to
   a. click on the file tab.
   b. select the “Save as” option.
   c. provide the file with a new name.
   d. all of the above

7. A good file name should
   a. contain punctuation such as slashes between the date's month and year.
   b. include the first line of the document.
   c. describe the content of the document.
   d. all of the above

8. When you retrieve a file, you can expect to find it
   a. in the Control Panel.
   b. in the Documents library.
   c. on the Desktop.
   d. all of the above

9. When you save a file to a flash drive, you should save it
   a. in the Documents library.
   b. on the hard drive.
   c. to the “Removable Disc” under “Computer.”
   d. all of the above

10. To save a document to a folder, you might
    a. create a folder, open it, and save the document in the folder.
    b. save a file, then drag it into a folder.
    c. all of the above
RESOURCES FOR BASIC COMPUTER SKILLS CLASSES
Websites and online training

http://www.youtube.com/watch?v=LrXeDF4Oqz4
This 2 ½ minute video by Commoncraft, “Computer Hardware in Plain English,” is an excellent overview of the hardware concepts taught in this module. It makes a very good review to show after the hardware section of the class is complete. The video uses explanation that are similar, yet a bit different, from those given in the trainings which broadens the conceptual understanding you can convey while reinforcing the terms and concepts.

http://www.youtube.com/watch?v=ytNAdnOaGl8
Another brief video by Commoncraft, “Computer Software in Plain English,” which complements the software section of this module extremely well. Show after the software section of the training module to reinforce and review concepts and terms. All materials by Commoncraft are very good.

http://www.gcflearnfree.org/computerbasics
One of many trainings created by Goodwill Inc., this series of modules, Basic Computer Skills, includes small, modularized units that cover a variety of basic computer topics. Most of these units are available as both text and brief videos, and, like the Commoncraft videos, are brief, clearly explained, and rich in images. Topics covered extend beyond basic skills and can be used for many other modules in both series of classes. Examples of other areas are Facebook, Twitter, and Internet Safety, each of which contain many different modules.

http://spclc.org/curricula/computer
This site, part of the St. Paul Community Literacy Consortium website, offers computer curriculum materials in text format suitable for handouts, review, and class guides. In addition to curriculum resources include written activities with teacher guides, exercises, and handouts with screencasts. The materials are all well done, but are also outdated, and would require editing for use with current versions of software. This site if rich and well-developed enough that using there materials as a starting point could be helpful, especially if using an older version of Windows or Office.

http://www.nwlincs.org/CompTech/Toc.htm
Based on the technology competencies set by the Kansas Board of Regents, the site provides presentation suggestions, handouts, and worksheets for basic computer skills. The handouts are well done, on very specific topics, and include screenshots, but like the materials on other sites are a few years outdated. However, the worksheets are not impacted by this and present a range of activities for the classroom in printed, handout form.
http://www.bbc.co.uk/webwise/courses/
Site produced by the BBC of Britain, the materials include learning modules in basic computer skills, Internet basics, online safety, social media, and more. Materials include videos, online printed materials, and a glossary of terms. The tone is upbeat and humorous, the range of topics broad, with attention to common questions and practical considerations. The material is up to date, the videos more conversational in tone than some, and includes complete sections on broadband, Internet security, using mobile apps, and more. It is a good way to review a specific topic or put a class at ease, but be aware of some differences in British and American systems and policies.
Instructional Strategies for Basic Computer Skills

Slide 1

New Mexico Broadband Program
Train the Trainer Toolkit
Instructional Strategies and Challenges
Basic Computer Skills

Slide 2

Basic Computer Skills

Learning Objectives
Basic Computer Skills
Understand key challenges
Acquire tools for successful delivery

Slide 3

Basic Computer Skills
Slide 4

Hard Drive
Random Access Memory
Software Icons
Desktop

Slide 5

Overwhelmed !!!

Slide 6

What can you do?

- Set realistic expectations
- Review terms frequently
- Provide handout AFTER training
- Reinforce in subsequent modules
Slide 7

Unfamiliar with a mouse

---

Slide 8

What can you do?

• Explain that new skills take time to learn
• Assure that practice will lead to ability
• Emphasize the challenge of new hand-eye coordination
• Compare to learning a new writing technique like calligraphy or Japanese lettering
• Provide fun exercises and games that can engage all levels

---

Slide 9

Desktop is a confusing term
and clicking a difficult skill to master

Slide 11

What can you do?

• Anticipate and head off confusion about terms
• Demonstrate clicking action and sound out speed with taps of a pointer or your knuckles
• Create kinesthetic understanding by placing your hand over student’s hand while clicking
• Drag and drop will need similar kinesthetic support

Opening and closing applications takes practice
and keyboarding may be stressful for those unfamiliar with this task.

What can you do?

- Repeat activity several times after learning, so students gain practice using skills
- Practice “preview, view, do, review”
- Provide reasonable expectations for timeline needed to acquire new skills such as keyboarding

Organization of information is difficult to understand when one cannot identify the physical storage locations
Slide 16

What can you do?

• Develop an analogy or comparison for computer locations, files, programs, and repeat it to enhance understanding
• Reuse the analogy or comparison each time you look at the Start menu or open a file, so students associate these tasks with those explanatory schemes
• Head off confusion by explaining that computer systems are redundant – there is more than one way to do most tasks

Slide 17

Some tools are difficult to understand until they are used

Slide 18

What can you do?

• Provide opportunities for directed exploration that allow students to gain intuitive understanding of tools before introducing complexity:
  - e.g.: Navigate into folders by clicking icons to open and using the Back arrow to return to starting point.
  - After this is practiced, introduce Forward arrow, noting it only works when you’ve “already been there.”
  - After this is practiced, introduce Breadcrumbs as verbal identifier of Arrow actions.
Slide 19

Multi-step tasks, such as saving a file, are more complex and harder to accomplish.

Slide 20

What can you do?

• Prepare students for a more complex task by describing it as such and emphasizing the need to follow step by step
• Preview-view-do-review
• Repeat the task
• Reassure that practice will build skills
• Distribute handouts DURING class

Slide 21

Word processing programs can overwhelm beginning users with a multiplicity of tools.
What can you do?

- Keep class focus on ONE tab only
- Keep class focus on the ORDER AND PATTERN of general areas of commands, rather than on specific commands
- Teach principles of command use – the ON/OFF “switch” - that will allow students to explore and utilize commands successfully
- Enlist assistance of more experienced users in keeping everyone “on task” and focused on large concepts

Remember:

- Aim for meeting a few important goals and be satisfied if these goals are reached
- Be prepared to adjust the quantity of material you cover, based on individual class composition and abilities
- Learn from each class and develop plans for gradual improvements
- An engaging, enjoyable instructional environment will always result in learning!

Thank you for helping to bring digital literacy to your community!

These materials were created collaboratively by the New Mexico Department of Information Technology, Fast Forward New Mexico, and the New Mexico State Library, under grants provided by the National Telecommunications and Information Administration. These materials are not to be used for profit.

Instructional strategies for Basic Computer Skills - training video